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�Installing Microsoft BackOffice 2.0 Server and Client

Welcome to the Microsoft® BackOffice™ Server 2.0 Installation Guide. This guide has been prepared to help you install the Microsoft BackOffice server and client applications. Since this guide has been prepared for the purpose of the test drives in the document titled Microsoft BackOffice Server 2.0 Test Drive, instructions in this guide may not be suitable for production environments.  Please refer to the respective manuals for information concerning the setup for production environments.

Computer 1:  BackOffice Server

Installing Windows NT Server 3.51

This section provides step-by-step instructions for installing Microsoft Windows NT® Server 3.51. If you are already familiar with installing Windows NT Server, use this check list as a guideline during installation.

System partition is NTFS format

Install as a Primary Domain Controller (PDC)

Installed protocols include NWLink IPX/SPX and TCP/IP (Address: 1.1.1.1; Subnet: 255.0.0.0)

Share the installed printer as Printer

Share out the root directory as C$

Service Pack 4 installed

To install Windows NT Server 3.51:

It is highly recommended that you start a fresh installation of Windows NT Server. To do so:

Ensure that you have the 3 boot floppies for Windows NT Server. If you do not, you can create these from a DOS workstation by typing source:\I386\WINNT/ O. Replace source with your CD drive letter and use the BackOffice CD #1.

Clear off all partitions by using FDISK. Do not create a new partition.

Insert floppy disk #1 into your drive and restart your computer.

Windows NT Server Setup will copy its installation files to the hard disk. Once the MS-DOS portion of Setup is complete, press enter to restart your computer and continue Windows NT Server setup.  After rebooting, a Welcome to Setup dialog box appears.

Press enter to continue with the setup. A dialog box appears asking you to choose between Express and Custom setup.

Press enter to select Express Setup. You will be asked to insert floppy disk #3. Press ENTER. A dialog box appears detailing the mass storage devices in your computer.

Make any additions that are necessary. When finished, press enter to continue. A dialog box appears listing the spaces available to install Windows NT Server.

Depending on how you are installing Windows NT Server, you will either:

Select an unpartitioned space

Create a partition in the unpartitioned space

Delete a highlighted partition

A dialog box appears detailing where you have chosen to install Windows NT Server and asks what type of file system you would like on this disk.

Again, depending on how you are installing Windows NT Server, you will either:

Format the partition as NTFS

Choose Convert the partition to NTFS

Choose to Format or Convert the partition to NTFS. Portions of Microsoft BackOffice require this.

NOTE: A dialog box may appear warning you that this will render the drive inaccessible to operating systems other than Windows NT Server. Press F or C to go ahead with the format or conversion.

You are asked what directory location to use to install Windows NT Server. Press enter to accept the default of \WINNT35. Your disks are examined, files are copied and then you are asked to restart your computer.

Press enter to restart your computer. Remove any floppy disks. A Windows NT Setup dialog box appears.

Enter your name and company and click Continue.  If you have a valid Product ID, enter it now as well.  Otherwise, leave it blank; it is not required.  When asked to confirm, click Continue. A Security Role dialog box appears.

Click Domain Controller and click Continue. A Choose Licensing Mode dialog box appears.

Click the Per Seat Licensing Mode and then click Continue. The Per Seat Licensing dialog box appears.

Click the I agree that: check box and click OK. A dialog box appears asking you to choose a computer name.

Enter a unique server name and click Continue. IMPORTANT:  Replace server with your chosen server name throughout the rest of the BackOffice install. When asked to confirm the name, click Continue. A Language dialog box appears.

Select the default of English and click Continue. A setup dialog box appears asking you to choose setup tasks.

Click all the tasks and then click Continue. An Optional Windows Components dialog box appears.

Click all the components and then click Continue. A Local Printer dialog box appears.

In the Printer Name box, type Printer. For the model, choose HP LaserJet 4 (alternatively, select the printer that you actually have). Leave the Print to box set at LPT1.  Click Continue. 

Setup looks for your network cards. Be sure to know the settings of your net card. When Windows NT cannot accurately detect your settings, it will display the most commonly used settings for your card.

If setup does not locate your network card, follow the dialog boxes to install you card’s driver from diskette. Modify any dialog boxes that appear with information about you hardware (i.e. IRQ levels, I/O Port Addresses and transceiver type). A dialog box appears with network protocol choices.

Click IPX/SPX and TCP/IP only and click Continue. Files are then copied to the correct install directory.  If you had to load your network card driver from diskette, leave this diskette in the drive during this process.  A Network Settings dialog box appears.

Click OK. The NWLink IPX/SPX Protocol Configuration dialog box appears.

Click OK to accept the defaults. The TCP/IP configuration dialog box appears.

If you are currently on a network that has a DHCP server, click Enable Automatic DHCP Configuration. If not, use the IP address of 1.1.1.1 and the subnet mask of 255.0.0.0 (no Default Gateway or WINS Servers). A Domain Settings dialog box appears.
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Click Primary Domain Controller and enter a unique domain in the selection box. Click OK. IMPORTANT:  Replace domain with your chosen domain name throughout the rest of the BackOffice install. Setup verifies that no other domain exists with the same name and then continues. The Administrator Account Setup dialog box appears.

Click Continue without setting a password for Administrator. Click OK to confirm that you want to leave the password blank. A Virtual Memory dialog box appears.

Click Continue to accept the default virtual memory settings.

Setup adds icons for miscellaneous programs it finds into an Applications group within Program Manager. Cancel the search or when Setup stops, click Cancel to stop the search. A Date/Time dialog box appears.

Enter your local information into the appropriate dialog boxes and then click OK. Setup detects your display adapter. Click OK to accept the detected display.

In the Display Settings dialog box, change the resolution to 800x600 and then click Test to be sure the adapter detected was correct. A test pattern should appear on the screen.

If the test was successful, click Yes, then OK twice to continue.

If Windows NT Server setup displays a dialog box at this point warning you that you have one of the Intel Pentium processors with the floating-point divide problem, click No to continue. A dialog box appears asking if you want to create the Emergency Repair disk.

Click No. A dialog box appears informing you that Setup is complete. Press ENTER or click the big button to restart your computer.

Your computer will restart a couple of times while converting the file system to NTFS. This is normal.

Logon to Windows NT Server as Administrator.

Copy the entire contents of the \I386 installation directory to C:\I386.  This facilitates adding and removing Windows NT services.

NOTE: When you install the Microsoft BackOffice Server 2.0 Installer, you will automatically be prompted to install Service Pack 4.



To record licenses in License Manager:

When choosing the Per Seat option during installation, it is not a requirement to record purchases in the License manager.  However, not doing so will result in error messages being posted to your Event Log.  Hence, it is recommended that you record 100 clients for each BackOffice application after each installation.  

From the Network Administration group in Program Manager, start License Manager.

On the License menu, click New License.

In the Product: box, select Windows NT Server. In the Quantity: box, type 100. (Do not purchase any licenses for the product marked BackOffice). Click OK. The Per Seat Licensing dialog box appears.

Click the I agree that: check box and then click OK.

Exit from License Manager and the Network Administration group.

To share the system printer as \\server\Printer:

From the Main group in Program Manager, start Print Manager.

On the Printer menu, click Properties.

Click the check box to share this printer and create a share name of Printer.

Click OK and exit Print Manager.

To set up Service Accounts for the BackOffice server applications:

Prior to installing the other Microsoft BackOffice applications, it is recommended to create the service accounts for Microsoft Exchange Server, Microsoft SMS Server and Microsoft SQL Server. The use of service accounts is optional except if you want to take advantage of the integration between Microsoft SQL Server and Microsoft Exchange Server. 

From the Administrative Tools group, start User Manager for Domains. The User Manager dialog box appears.

On the User menu, click New User. The User Properties dialog box appears.

In the User Properties dialog box, enter the following information:

Username: ExchangeAccount

Full Name: Leave blank

Description: Service Account for Microsoft Exchange Server

Password: Leave blank

Confirm Password: Leave blank

Click on User Cannot Change Password and Password Never Expires check boxes

Deselect User Must Change Password at Next Logon check box

Click the Groups button. The Group Memberships dialog box appears.

In the Group Memberships dialog box, from the Not member of: box, select Administrators and click Add. Similarly add the Domain Admins group. 

Click OK to return to the User Manager dialog box.

Similarly add user accounts for Microsoft SQL Server (SQLAccount) and Microsoft Systems Management Server (SMSAccount).

In the User Manager dialog box, on the Policies menu, click User Rights. The User Rights Policy dialog box appears.

Click Show Advanced User Rights check box.

In the Right: field, using the drop-down arrow, click Log on as a service.

Click Add. The Add Users and Groups dialog box appears.

Click the Show Users button. 

Select ExchangeAccount and click Add. Similarly add Administrator, SQLAccount and SMSAccount. 

Click OK twice and then exit from User Manager for Domains.

Installing the Microsoft BackOffice Server 2.0 Installer

The BackOffice Installer offers you a unified way to install the BackOffice server applications.

To start the Microsoft BackOffice 2.0 Installer setup, run SETUP.EXE from the BackOffice 2.0 CD#1.

Setup creates the BackOffice 2.0 program group and then displays a Welcome to Setup message.

Click Continue. A Pre-installation Information dialog box appears.

Click OK. The Name and Organization Information dialog box appears.

Enter in your name and Organization’s name.  If you have a valid Product ID, enter it now as well.  Otherwise enter 1234567—it is required. Click OK.

A dialog box appears saying that Service Pack 4 (SP4) was not detected. Click OK to install Service Pack 4 now. The program installs SP4 files onto your hard disk. After the files are installed, the system will automatically shut down and restart. 

Logon to the Server as Administrator.

From the Microsoft BackOffice 2.0 Installer program group, start the Microsoft BackOffice 2.0 Installer. A Welcome to the Microsoft BackOffice 2.0 installation program dialog box appears.

Click Continue. A Pre-installation Information dialog box appears.

Click OK. The Name and Organization Information dialog box appears. 

Click OK. The Microsoft BackOffice 2.0 Installer dialog box appears with all the BackOffice applications listed.

Click all the applications (except Windows NT Server 3.51) and click OK. A dialog box appears asking you to insert CD#2. 

Insert CD#2 and click OK.  A Welcome to Setup dialog box appears for Microsoft SQL Server 6.5.

Installing Microsoft SQL Server 6.5

This section provides step-by-step instructions for installing Microsoft SQL Server 6.5.  If you are already familiar with installing Microsoft SQL Server, use this check list as a guideline during installation:

Create system user account (SQLAccount) with local administrator and domain administrator privileges, no password, and Log on as a Service user right.

Master device should be at least 25 MB (default)

Add network support for the following protocols: Named Pipes, Multi-Protocol, NWLink IPX/SPX and TCP/IP Sockets

Configure to Auto Start both SQL Server and SQL Executive

Use SQLAccount as the system (service) account

Do not enable Multi-Protocol encryption



At the Welcome to Setup dialog box, click Continue. A dialog box appears asking for your name, organization and product ID.

Enter in your name and Organization’s name. If you have a valid Product ID, enter it now as well.  Otherwise, leave it blank—it is not required. Click Continue. When asked to verify your input, click Continue. The SQL Server 6.5 Options dialog box appears with Install SQL Server and Utilities selected.

Click Continue. A Choose Licensing Mode dialog box appears.

Click the Per Seat check box and then click Continue. The Per Seat Licensing dialog box appears.

Click the I agree that: check box and then click OK. The SQL Server Installation Path dialog box appears.

Click Continue to accept the defaults. The MASTER Device Creation dialog box appears.

Select the location and size of the Master device. Unless you have a reason for doing so, accept the defaults. Click Continue. The SQL Server Books Online dialog box appears.

Books Online requires about 15MB of extra hard disk space. You can choose whether you want to install or not install Books Online at this point. Click the appropriate option and then click Continue. The Installation Options dialog box appears.

Click the Networks button and select the following protocols:  Names Pipes, Multi-Protocol, NWLink IPX/SPX and TCP/IP Sockets.  Click OK.

Click the check boxes to Auto Start both SQL Server and SQL Executive at boot time. Click Continue. A SQL Executive Log On Account dialog box appears.

Type domain\SQLAccount for the account name. Do not enter any password since the password is blank. Click Continue. The Multi-Protocol Encryption dialog box appears.

Do NOT enable encryption. Click Continue. The Novell Bindery Service Name dialog box will appear with the computer name set as the default.

Click Continue. The TCP/IP Socket Number dialog box appears with the port number set to a default of 1433.

Click Continue. Microsoft SQL Server setup now copies files to your hard disk. Once finished, a dialog box appears indicating that SQL Server is now installed and asks you to Exit to Windows NT.

NOTE: If you get an error saying that the file MSVCRT40.DLL cannot be opened, then alt-tab to the Services program in the Control Panel group and stop Exchange Server services. Exit from Control Panel.

In the Error Message dialog box, click Retry.

Click the Exit to Windows NT button. A dialog box appears asking you to insert CD#3.

Insert CD#3 and then click OK. A Welcome to Setup dialog box appears for Microsoft Exchange Server 4.0. 

Installing Microsoft Exchange Server 4.0

This section provides step-by-step instructions for installing Microsoft Exchange. If you are already familiar with installing Microsoft Exchange Server, use this check list as a guideline during the  installation:

Ensure Windows NT Server 3.51 Service Pack 4 is installed

Create system user account (ExchangeAccount) with local administrator and domain administrator privileges, no password, and Log on as a service user right

Use Complete setup

Create a new site using valid SMTP names (see below for more info)

Use ExchangeAccount as the system account

Run the Microsoft Exchange Optimizer with the default settings.

At the Welcome to Setup dialog box, click OK. A dialog box appears asking you to choose the type of setup.

Click Complete/Custom. This will install all mail connectors (MS Mail, SMTP and X.400), Books Online and Exchange Administrator. An options dialog box appears.

Click Continue. A Choose Licensing Mode dialog box appears.

Click the Per Seat check box and then click Continue. The Per Seat Licensing dialog box appears.

Click the I agree that: check box and the click OK. An Organization and Site dialog box appears with Create a new site selected.

Be sure your Organization Name and Site name are valid SMTP names (i.e. no spaces; for instance, Microsoft for Organization and Redmond for Site). Microsoft Exchange currently uses Site.Organization.COM to create your SMTP addresses.  Click OK. A dialog box asks you to confirm the creation of a new site.

Click Yes. The Site Services Account dialog appears asking you for the correct service account.

Click on the Browse button to select the service account you created for Microsoft Exchange Server. The Add User or Group dialog box appears.

In the Add User or Group dialog box, highlight ExchangeAccount, do not enter a password (leave blank), click Add and then click OK. 

At the Site Services Account dialog box, click OK. Microsoft Exchange Server setup now copies files to your hard disk. 

NOTE: If you get errors saying  that MSVCRT20.DLL and/or CTL3D32.DLL cannot be copied, click Ignore for each error. These files are currently being used by Windows NT Server; the versions on the hard disk are the same as those that setup is trying to install.

After the files are copied, a dialog box appears indicating that Microsoft Exchange Server is now installed and asks whether you want to run the Optimizer or Exit Setup.

Click Run Optimizer. 

A dialog box appears asking you to insert CD#4. It is recommended that you run Microsoft Exchange Optimizer and then return to the installer dialog box. Alt-tab to the Microsoft Exchange Performance Optimizer.

Click Next to start the optimizing wizard.

Based on your needs, change settings as necessary. For typical demo and test setups, click Next to accept the default settings. If you have only one formatted drive in your system, the optimizer warns you of this.

Click Next to bypass this message. (Microsoft Exchange performs better when it can spread files across several disks, though this is not necessary).

Click Finish to restart the Microsoft Exchange Server services.

The installer dialog box that asked you to insert CD#4 appears. If it does not appear, press Alt-Tab to get to the dialog box.

Insert CD#4 into your server CD-ROM drive and that click OK. A Welcome to setup dialog box appears for Microsoft Internet Information Server 1.0.

Installing Microsoft Internet Information Server 1.0

At the Welcome to Setup dialog box, click OK. A dialog box appears showing you the software components and the directory that setup will install.

Click OK. This will perform a complete install. A dialog box appears asking if you want to create the installation directory.

Click Yes. A dialog box appears showing you the default publishing directories for WWW, FTP and Gopher services.

Click OK, and then click Yes to confirm the creation of these directories. Installation files are copied to your server.  A dialog box appears asking you to select ODBC drivers to install.

Select SQL Server and then click OK. 

If you installed Microsoft SQL Server 6.5 prior to installing Microsoft Internet Information Server, a dialog box will appear asking you to confirm replacing the ODBC driver originally installed. Click No. 

NOTE: If you get a dialog box that says “Cannot install file c:\winnt35\system32\ODBC32.DLL, click Ignore.

Similarly, if you get a dialog box that says “Cannot install file c:\winnt35\system32\ODBCINT.DLL, click Ignore.

Once finished, a dialog box appears indicating that the Internet Information Server is now installed.

Click OK. A dialog box appears asking you to insert CD#2.

Insert CD#2 and click OK. A Welcome to Setup dialog box appears for Microsoft SNA Server.

Installing Microsoft SNA Server 2.11

This section provides step-by-step instructions for installing Microsoft SNA Server 2.11.  If you are already familiar with installing SNA Server, use this check list as a guideline during installation:

All default client/server protocols are included

Install as Primary Configuration Server

Install all four Demo SDLC scripts

A the Welcome to Setup dialog box, click Continue. A Choose Licensing Mode dialog box appears.

Click the Per Seat check box and then click Continue. The Per Seat Licensing dialog box appears.

Click the I agree that: check box and then click OK.  A dialog box appears asking for your name, organization and product ID.

Enter your name and Organization’s name. If you have a valid Product ID, enter it now as well.  Otherwise, leave it blank—it is not required.  Click Continue. When asked to confirm your name and organization, click OK. The Installation Path dialog box appears with C:\SNA set as the default.

Click Continue. The Select Client/Server Protocols dialog box appears with Named Pipes, IPX/SPX, and TCP/IP selected (assuming you installed IPX/SPX and TCP/IP).

Click Continue. An Important Information dialog box appears suggesting that you read Appendix A of the SNA Server Planning Guide for information about Named Pipes and other protocols.

Do not check the box to disable the popup and click Continue. A Network Domain Name dialog box appears with the computer’s domain selected.

Click Continue. An SNA Server Role dialog box appears with Primary Configuration Server selected.

Click Continue. A Review Settings dialog box appears.

Click Continue to bypass installing documentation. If you choose to install the on-line documentation, plan for an additional 14 MB of disk space. SNA Server setup copies files and configures your system.  A Link Service Installation dialog box appears.

Select DEMO SDLC Link Service and click Install. The DEMO SDLC Link Service Setup dialog box appears. 

NOTE: This is required for the setup of samples.  If you need a link to a particular host and know what type of link service to add, you may add this as well.  Adding unnecessary link services may result in errors both in SNA Server and the event log. 

Leave the Service Title set at the default = DEMO SDLC Link Service #1. Leave the Script file set at 3270 Continuous Demo. Click Continue. The Link Service Configuration dialog box appears.

Click Add to install another link service.

Select DEMO SDLC Link Service and click Install. The DEMO SDLC Link Service Setup dialog box appears.

Leave the Service Title set at the default, DEMO SDLC Link Service #2.  Change the Script file to 3270 Logon Demo. Click Continue. The Link Service Configuration dialog box appears.

Click Add to install another link service.

Select DEMO SDLC Link Service and click Install. The DEMO SDLC Link Service Setup dialog box appears.

Leave the Service Title set at the default, DEMO SDLC Link Service #3. Change the Script file to AS400 Demo. Click Continue. The Link Service Configuration dialog box appears.

Click Continue. A Setup Message appears asking you to run the SNA Admin program to configure these connections.

Click OK. A dialog box appears informing you that SNA Server Setup is complete.

Click Exit. 

NOTE: You can configure the SNA Server Admin. later.

A Welcome to Setup dialog box appears for Microsoft Systems Management Server 1.1.

Installing Microsoft Systems Management Server 1.1

This section provides step-by-step instructions for installing Microsoft Systems Management Server 1.1. 

In the Systems Management Server Setup dialog box, click Continue. A Registration dialog box appears asking for your name, organization and product ID.

Enter in your name and Organization’s name. If you have a valid Product ID, enter it now as well.  Otherwise, enter 1234567—an ID is required for Systems Management Server.  Click Continue.

When asked to confirm your name and organization, click Continue. The Installation Options dialog box appears with two buttons enabled.

Click Install Primary Site. A Licensing  dialog box appears. Microsoft Systems Management Server supports Per Seat licensing only.

Click the I agree that: check box and then click OK. A setup dialog box appears explaining that you must have a system account set up for Systems Management Server and a SQL Server installed.

Click Continue. The Installation Directory dialog box appears.

Click Continue to accept the defaults. The Setup Install Options dialog box appears.

Click Continue.  The Microsoft SQL Database Configuration dialog box appears.

Click Continue without entering a password (password is blank). Setup attempts to start a SQL connection.  If this fails, check the Services program in Control Panel to ensure that both the MSSQLServer and SQLExecutive services are started and then retry.  The Primary Site Configuration Information dialog box appears.

NOTE: If a SQL Connections dialog box appears, click the Ignore button.

In the Primary Site Configuration Information dialog box, complete the following:

Site Information

Site Code: CS1

Site Name: Corporate

Site Server: Your BackOffice server name

Site Server Domain: Your domain name

Service Account

Username: SMSAccount

Password: Do not enter a password (blank password)

Click Continue

NOTE: If you haven’t assigned SMSAccount Log on as a service rights, then a warning dialog box appears asking if you want to grant the SMSAccount account SERVICE LOGON system access. Click Yes. A dialog box appears indicating that the account modification was successful. Click OK.

Setup installs files, creates the SMS database structure and initializes the system. A dialog box appears providing instructions on installing the Network Monitor Driver. Read the instructions, then click OK.

Setup completes and a Setup Success dialog box appears. Click OK. 

Alt-Tab to the Microsoft BackOffice Installer dialog box, which confirms the installation of all selected applications. Click OK. The Microsoft BackOffice 2.0 Installer dialog box appears. 

Click Close. A dialog box appears asking you if you are sure you want to quit? Click Yes.

You will now be in the Network Settings dialog box. Click Add Software. The Add Network Software dialog box appears.

In the Network Software: box, using the drop down arrow, click Network Monitor Agent. Click Continue. You are returned to the Network Settings dialog box.

Click OK. The network is reconfigured and you are notified that you need to restart your system for changes to take effect.

Click Restart Now. 

The systems shuts down and restarts. Logon to the BackOffice server as Administrator. 



You now need to configure the BackOffice server applications.

Configuring Microsoft Exchange Server 4.0

To configure the Exchange Administrator:

Make sure all the Microsoft Exchange Server services are running. This can be done using the Services program in Control Panel. 

From the Microsoft Exchange program group in Program Manager, start Microsoft Exchange Administrator. 

In the Connect to Server dialog box, type in the name of your BackOffice server (or you can use the Browse button to select your server name) and then click OK.

Double-click on organization name. 

Click the + next to site name and then select Recipients.

On the File menu, click New Mailbox. The Properties sheet for a new recipient appears.

Fill out the General tab of this form as follows:

First: Administrator

Display: automatically fills with Administrator

Alias: automatically fills with Administrator

Click the Primary Windows NT Account button.

In the Primary Windows NT Account dialog box, click Select an existing Windows NT account and click OK.

In the Add User or Group dialog box, select Administrator and click Add. Click OK.

Click OK.

Follow the same procedure to add mailboxes for ExchangeAccount and SQLAccount.

In the Exchange Administrator dialog box, highlight Organization and on the File menu, click Properties.

In the Properties dialog box, click the Permissions tab.

Highlight domain name\ExchangeAccount and change its role to Service Account Admin using the drop-down arrow under Roles:. Click OK. The Microsoft Exchange Administrator dialog box appears.

On the Tools menu, click Options. The Options dialog box appears.

Click the Permissions tab. 

Click the following check boxes:

Show Permissions page for all objects

Display rights for roles on Permissions page

Try to find matching Windows NT account when creating mailbox

15.	Click OK. Exit from Exchange Administrator.

Configuring Microsoft Internet Information Server 1.0

To configure Microsoft Internet Explorer’s Startup Home Page:

From the Microsoft Internet Server program group in Program Manager, start Internet Explorer.

On the View menu, click Options. The Options dialog box appears.

Set Startup Home Page: to http://server. Click OK.

Exit from the browser (Internet Explorer).

To configure the ODBC Data Source Name Driver:

The samples that ship with the Internet Information Server need a Data Source Name (DSN) driver configured. To configure this:

From the Main program group, start Control Panel.

From the Control Panel group, start the 32-bit ODBC program. The System Data Sources dialog box appears.

Click System DSN and then click Add. The Add Data Source dialog box appears.

Click SQL Server then OK. The ODBC SQL Server Setup dialog box appears.

In the ODBC SQL Server Setup dialog box, complete the following:

Data Source Name:  Web SQL

Description: Internet Database Connector

Server: Type the name of your BackOffice server

Do not click the Use Trusted Connection check box

Click the Options button. The dialog box expands

Database Name: Pubs

Click OK and then click Close twice.

Exit from Control Panel and from the Main program group.

Configuring Microsoft SNA Server 2.11

This section includes step-by-step instructions for configuring the demo SDLC links you setup during the Microsoft SNA Server installation. 

From the Microsoft SNA Server program group, start SNA Server Admin.

To configure the 3270 Continuous Demo Link:

In the Servers and Connections dialog box, select SDLC1. On the Services menu, click Properties. Configure as follows:

Link Service:  SnaDemo1

Remote End:  Host System

Activation:  On Demand

Click the Setup button to open the SDLC Setup dialog box. No configuration changes are necessary. Click OK to close the dialog box

Click OK to close the Connection Properties dialog box.

In the Servers and Connections dialog box, highlight SDLC1. On the Services menu, click Assign LUs.

In the Insert LU dialog box, select 3270 and click OK.

In the New 3270 LU Properties dialog box, type FLASH in the LU Name field and click OK.

Select the Users and Groups icon and on the Users menu, click New User.  

In the Add Users and Groups dialog box, highlight the Administrators group, click Add and then click OK.

In the Users and Groups dialog box, highlight the Administrators group you just added. On the Users menu, click Assign LUs.  Select FLASH and click OK.

To configure the 3270 Logon Demo Link:

In the Servers and Connections dialog box, select SDLC2. On the Services menu, click Properties. Configure as follows:

Link Service: SnaDemo2

Remote End: Host System

Activation: On Demand

Click the Setup button to open the SDLC Setup dialog box. No configuration changes are necessary. Click OK to close the dialog box.

Click OK to close the Connection Properties dialog box.

In the Servers and Connections dialog box, highlight SDLC2. On the Services menu, click Assign LUs.

In the Insert LU dialog box, select 3270 and click OK.

In the New 3270 LU Properties dialog box, type LOGON in the LU Name field and click OK.

Highlight the Administrators group in the Users and Groups dialog box, and on the Users menu, click Assign LUs. Highlight LOGON and click OK.

Select the LU Pools dialog box and on the Pools menu, click New Pool. Type POOL for Pool Name and click OK.

With POOL highlighted in the LU Pools dialog box, on the Pools menu, click Assign LUs.

Hold down the CTRL key and select both LUs (FLASH and LOGON), then click OK.

To configure the AS/400 5250 Continuous Demo Link:

In the Servers and Connections dialog box, highlight SDLC3 and on the Services menu, click Properties.  Configure as follows:

Link Service:  SnaDemo3

Remote End:  Peer System

Activation:  On Demand

Click the Setup button to open the SDLC Setup dialog box.

In the SDLC Setup dialog box, type APPN for Network Name and REMOTE for Control Point Name. Click OK to close this dialog box.

Click OK to close the Connection Properties dialog box.

Answer Yes to create a Remote APPC LU.

In the LU Name dialog box, press TAB. The LU Name and the Uninterrupted LU Name fields will be filled in with REMOTE. Click OK.

Highlight the Administrators group in the Users and Groups dialog box, and on the Users menu, click Properties. In the Group Properties dialog box, change the Local LU Alias to LOCAL and the Remote LU Alias to REMOTE.  Click OK.

To complete configuration:

Exit from SNA Server Admin, answering Yes to save the changes to configuration.

Configuring Microsoft SQL Server 6.5

To register your server:

From the Microsoft SQL Server 6.5 program group in Program Manager, start SQL Enterprise Manager.

The Register Server dialog box appears. (If this dialog box does not appear, on the Server menu, click Register Server).

Click the Servers button. 

In the Select Server dialog box, click Refresh. Highlight your BackOffice server name in the Active Servers box, and click OK.

Click the Use Trusted Connection check box. Click Register and then click Close.

To set up security for logins:

In the Microsoft SQL Enterprise Manager dialog box, highlight your BackOffice server name. Right click on your mouse (or) on the Server menu, click on Configure. The Server Configurations/Options dialog box appears. 

Click the Security Options tab.

Click Mixed Login Security Mode.

Click the Failed Logins check box.

Click Apply Now and then click OK.

Exit from SQL Enterprise Manager.

Configuring SQLMail

You first need to install the Microsoft Exchange client on your server. You need to configure a profile for the Microsoft SQL Server service account SQLAccount you created earlier.

To install the Microsoft Exchange Client on your server:

Ensure that you are logged in as Administrator. Insert CD#4 into your server. Using File Manager, browse to the location of the client source files (\exchange\clients\eng\winnt\i386) and run SETUP.EXE.

A Welcome to Setup dialog box appears. Click Continue. A dialog box appears asking for your name and organization.

Enter in your name and organization’s name. Click OK. 

A dialog box will appear asking you to confirm your name and organization. Click OK. Setup asks you to confirm the destination file location.

Click OK to accept the default location. A Microsoft Exchange Setup dialog box appears.

Click Typical. The Choose Program Group dialog box appears.

Click Continue. Files are copied to your hard disk. A dialog box appears indicating that the Microsoft Exchange Client is now installed.

Click OK.

To create a user profile for the Administrator:

From the Main program group, start Control Panel.

From the Control Panel group, start Mail and Fax.

In the Mail and Fax dialog box, click Add.

In the Microsoft Exchange Setup Wizard, click the Manually configure information services check box. Click Next.

Type in Administrator for Profile Name. Click Next.

In the Properties page, click Add. The Add Service to Profile dialog box appears.

Click Microsoft Exchange Server service ONLY. Click OK. The Microsoft Exchange Server dialog box appears.

In the General tab of the Microsoft Exchange Server dialog box, use your BackOffice server name for the Microsoft Exchange server: field, and Administrator in the Mailbox: field. Click the Check Name button.

Accept all other defaults. Click OK twice.

Click Do not add Exchange to the Startup group and click Next.

Click Finish.

Exit from Control Panel and from the Main program group.

To configure Exchange to work with Microsoft SQL Server:

From the Microsoft Exchange program group, start Microsoft Exchange Administrator. If you have not created a mailbox for SQLAccount (Microsoft SQL Server service account), do so now.  

Highlight the SQLAccount mailbox. On the File menu, click Properties.

In the Recipient Properties dialog box, click the Permissions tab.

In the SQLAccount Properties dialog box, click Add.

In the Add Users and Groups dialog box, select Administrator and click Add. Click OK. This allows Administrator to use this inbox as a user.

Exit from Microsoft Exchange Administrator.

From the Microsoft SQL Server 6.5 program group in Program Manager, start SQL Setup.

Click Continue twice. 

In the Microsoft SQL Server 6.5 - Options dialog box, click Set Server Options and then click Continue.

In the Select Server Options dialog box, click Auto Start Mail Client and then click the Change Options button. The Exchange Login Configuration dialog box appears.

In the Profile Name: dialog box, type SQLAccount and then click Continue.

Click the Exit to Windows NT button.

Log off the BackOffice server and logon as SQLAccount.

Create a Microsoft Exchange profile for SQLAccount and then logoff the server.

Logon as Administrator. 

Ensure that the MSSQLServer service logs on as SQLAccount. To do so, start the Services program in Control Panel. Scroll down to the MSSQLServer service and double-click on this. In the Service dialog box, make sure that the Automatic and This Account check boxes are selected. Also, domain\SQLAccount should be the entry in the This Account field. If not, type in it or use the Ellipse button to add this account.

Click OK. In the Services dialog box, stop MSSQLServer and SQLExecutive services. Start these services. 

Click Close and then exit from Control Panel.

�Computer 2:  Windows 95 Client

This section provides a guideline for installing the Microsoft Windows 95 client with all supporting client software. As users of this document should be familiar with installing Windows 95, use the following  checklists during installation to be sure your installation is compatible with BackOffice.

Installing Microsoft Windows 95 Operating System

Custom install:  Select everything

Network Configuration:  use the defaults except for the following:

Remove NetBEUI and add the TCP/IP protocol

Enable file and printer sharing

Configure Client for Microsoft Networks to log into your domain

Workgroup Name: your domain

Set resolution to 800x600 and use high color

Connect to your shared network printer \\server\PRINTER

Installing Microsoft Plus! for Windows 95 (Optional)

Custom install—select everything except the following:

System Agent

Internet Jumpstart Kit

Once installed, use display properties to stretch desktop wallpaper

Installing Microsoft Office95, Microsoft Project95 and Microsoft Access95

Custom install—select all components except Schedule+ and Bookshelf®

Once installed, remove Office Shortcut Bar from the startup group

Installing the Microsoft BackOffice 2.0 Client Installer

Ensure that you are logged on to the Windows 95 client as the Administrator. The recommended approach is to copy all the client install files from the CDs to a server and install the BackOffice client applications from the server. 

Create a directory (say CLIENT) on the server for the client files. Copy the following directories (which will also copy all the contents of these directories) from the CDs to the CLIENT directory on the server:

The \boclient directory from CD#1

The \sna211\CLIENTS directory from CD#2

The \sql65 directory from CD#2

The \exchange\clients directory from CD#4

The \inetsrv\CLIENTS directory from CD#4



The directory hierarchy on the server should look like:

� INCLUDEPICTURE "L:\\BackOffice\\Docs in Progress\\FINAL Reviewer's Guide\\Bitmaps\\Installation.bmp" \* MERGEFORMAT ���

Right-click your mouse on the Network Neighborhood icon. Click on Map Network Drive. The Map Network Drive dialog box appears. In the Path box, type \\name of your server\CLIENT.

Using Windows Explorer, browse to \boclient on the server and then run SETUP.EXE. 

To install the client applications using the CDs instead - Insert CD#1 into your CD-ROM drive. Using Windows Explorer, browse to \boclient on CD#1 and run SETUP.EXE.

NOTE: The rest of the client setup assumes you are installing from the CDs. 

A Welcome to installation program dialog box appears. Click Continue. The Microsoft BackOffice 2.0 Client Installer dialog box appears with all the BackOffice client applications listed.

Select all the applications and the click OK. 

A Setup dialog box appears asking you to select a new BackOffice directory. 

NOTE: If you install from the server, you will not be prompted for a directory

Click Yes. A Select BackOffice Path dialog box appears. Insert CD#4 and then click OK. 

A Welcome to setup dialog box appears for the Microsoft Exchange client. 

Installing Microsoft Exchange Client 4.0

To install the Microsoft Exchange Client on your client:

At the Welcome to setup dialog box, click Continue. A dialog box appears asking for your name and organization.

Enter in your name and your organization’s name. Click OK. A dialog box will appear asking you to confirm your name and organization. 

Click OK. A dialog box appears asking you to confirm the destination file location.

Click OK to accept the default location. A Microsoft Exchange Setup dialog box appears with three setup options including Typical, Custom and Laptop.

Click on the Custom button. The Microsoft Exchange - Custom dialog box appears.

Click Select All and then click Continue. 

Files are copied to your hard disk. A dialog box appears indicating that the Microsoft Exchange Client was setup successfully. Click OK.

A Setup dialog box appears asking you to select a new BackOffice directory. 

NOTE: If you install from the server, you will not be prompted for a directory

Click Yes. A Select BackOffice Path dialog box appears. Click OK. 

A dialog box appears asking you if you wish to install Microsoft Internet Explorer Version 2.0.  

Installing Microsoft Internet Explorer 2.0

To install the Internet Explorer on your client:

At the dialog box asking you if you wish to install Microsoft Internet Explorer Version 2.0, click Yes.

The Internet Explorer License Agreement dialog box appears. Click I Agree. 

Files are copied to your hard drive. A dialog box appears indicating that the Internet Explorer Update is complete. Click OK.

A Setup dialog box appears asking you to select a new BackOffice directory. 

NOTE: If you install from the server, you will not be prompted for a directory

Click Yes. A Select BackOffice Path dialog box appears. Insert CD#2 and the click OK. 

A Welcome to setup dialog box appears for the Windows 95 client for SNA Server.

Installing the Windows 95 Client for Microsoft SNA Server

At the Welcome to setup dialog box, click Continue. The Name and Organization Information dialog box appears. 

Type in your name and organization name and click OK. A dialog box appears asking you to confirm the name and organization name.

Click OK. A dialog box appears with a setup location for the files.

Click OK to accept the default location. A dialog box appears with two setup options - Complete and Customized.

Click the Complete button. A dialog box appears with a default Program Group for the client. 

Click Continue to accept the default. The Licensing Agreement dialog box appears.

Click Yes (under I agree). The Client/Server Protocols dialog box appears.

Click TCP/IP and then click Continue. The SNA Client Mode dialog box appears.

Click the Local (same domain) check box, and then click Continue. The Network Domain Name dialog box appears.

In the Domain Name: box, type in the name of your domain and then click Continue. Files are copied to your hard drive. A dialog box appears saying the Windows 95 Client for SNA Server was completed successfully. Click OK. 

A Setup dialog box appears asking you to select a new BackOffice directory. 

NOTE: If you install from the server, you will not be prompted for a directory

Click Yes. A Select BackOffice Path dialog box appears. Click OK. 

A Welcome to setup dialog box appears for the Microsoft SQL Server Client Tools.

Installing the Microsoft SQL Server Client Tools for Windows 95

At the Welcome to setup dialog box, click Continue.

A dialog box appears with the default setup location. Click Continue to accept the default.

A dialog box appears with several installation options. Under Installation Options: make sure that the SQL Server Books Online check box is not selected. Accept all other defaults and click Install.

Files are copied to your hard disk. A dialog box appears saying Setup Succeeded. Click OK. 

The Microsoft BackOffice 2.0 Client Installer dialog box appears. Click Close. 

A dialog box appears asking you if you are sure you want to exit. Click Yes. 

Installing the Microsoft Systems Management Server (SMS) Client for Windows 95

To manually install the Microsoft Systems Management Server client:

Ensure that you are logged on to the Windows 95 client as the Administrator.

Right-click your mouse on the Network Neighborhood icon. Click on Map Network Drive. The Map Network Drive dialog box appears.

In the Path box, type \\name of your BackOffice server\SMS

Using Windows Explorer, browse to \logon.srv on the BackOffice server.

Run the RUNSMS.BAT program. This batch file will install the SMS client files on the Windows 95 machine and then inventory the machine’s hardware and software.

Run the RUNSMS.BAT program two more times and then restart the Windows 95 client.

The changes will take place after the machine has been restarted. Logon to the Windows 95 client as the Administrator.



Now you need to configure your BackOffice client applications.

Configuring the Microsoft Exchange 4.0 Client

To create a user profile:

Click on the Start button on your taskbar, and then from Settings\Control Panel, start the Mail and Fax program.

In the Mail and Fax dialog box, click Add. The Inbox Setup Wizard dialog box appears.

Click the Manually configure information services check box and then click Next.

Type in Administrator for Profile Name. Click Next.

In the Properties page for this profile, click Add. The Add Service to Profile dialog box appears.

Click Microsoft Exchange Server service ONLY. Click OK. The Microsoft Exchange Server dialog box appears.

In the General tab of the Microsoft Exchange Server dialog box, complete the following information:

Microsoft Exchange server: Type your BackOffice server name.

Mailbox: Administrator

Click the Check Name button.

Accept all other defaults. Click OK. The Properties dialog box appears. 

Click OK. The Inbox Setup Wizard dialog box appears.

Click the Do not add Exchange to the Startup group check box, and then click Next.

Click Finish. The Mail and Fax dialog box appears.

Click Close and then exit from Control Panel.

Configuring Microsoft Schedule+

Click on the Start button on your taskbar, and then from Program start Microsoft Schedule+. The Choose Profile dialog box appears.

Using the drop-down arrow in the Profile Name: box, click on Administrator. Click OK. The Microsoft Schedule+ dialog box appears.

Click the I want to create a new schedule file check box, and then click OK. The Select Local Schedule dialog box appears with a name and location for your Schedule+ information. Click Save.

The Microsoft Schedule+ dialog box for your profile opens. Exit from Schedule+.

Configuring Microsoft Internet Explorer 2.0

Start the Microsoft Internet Explorer 2.0. In the Address: box, type http://name of your server. Hit the Return key on your keyboard. The Microsoft Internet Information Server page appears.

On the View menu, click Options. The Options dialog box appears.

Click the Start and Search Pages tab. Click Use Current and then click OK.

Exit from Microsoft Internet Explorer.

Configuring the Windows 95 Client for Microsoft SNA Server

Click on the Start button on your taskbar, and then from Programs\SNA Client for Windows 95, run the SNA Client 3270 Applet. 

On the Session menu, click Session Configuration. The 3270 Settings dialog box appears.

Click FLASH for LU or Pool Name: and then click OK. On the Session menu, click Connect. You will get a green screen with a Space Needle. Exit from the 3270 Client.

Click on the Start button on your taskbar, and then from Programs\SNA Client for Windows 95, run the SNA Client 5250 Applet. 

On the Session menu, click Session Configuration. The Session Configuration dialog box appears.

Under Local LU Alias, type LOCAL. Under Partner LU Alias, type REMOTE. Click OK.

On the Session menu, click Session Configuration. A Sign-on dialog box appears. Type SNA for User ID: and SNA for password and then click OK. A green screen appears. Exit from the 5250 Applet.
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